
 

 
 

For EasyBuilder Pro V 3.00.03 



                                                              EasyBuilder User Manual 

 
 

1 

 

Chapter 1 EasyBuilder Installation and Startup Guide .........................................................11 

1.1 EasyBuilder Installation ..........................................................................................11 

1.2 Steps to Install EasyBuilder ....................................................................................12 

Chapter 2 Utility Manager ....................................................................................................18 

2.1 HMI IP, Password ...................................................................................................19 

2.2 Editing Tools ...........................................................................................................20 

2.2.1 Build Download Data for Saving in SD Card or USB Disk ............................20 

2.2.2 Steps to Download Project to HMI via USB Disk or SD Card .......................21 

2.3 Transfer ..................................................................................................................22 

2.3.1 Download .....................................................................................................22 

2.3.2 Upload ..........................................................................................................24 

2.4 Simulation ...............................................................................................................25 

2.4.1 Off-line Simulation / On-line Simulation ........................................................25 

2.5 Pass-Through .........................................................................................................27 

Chapter 3 Create an EasyBuilder Pro Project .....................................................................28 

3.1 Create a New Project .............................................................................................28 

3.2 Save and Compile the Project ................................................................................30 

3.3 Off-line and On-line Simulation ...............................................................................31 

3.4 Download the Project to HMI ..................................................................................32 

Chapter 4 Hardware Settings ..............................................................................................37 

4.1 I/O Ports .................................................................................................................37 

4.2 System Settings ......................................................................................................38 

4.2.1 System Reset ...............................................................................................38 

4.2.2 System Toolbar ............................................................................................39 

4.2.3 System Information ......................................................................................40 

4.2.4 System Setting .............................................................................................40 

Chapter 5 System Parameter Settings ................................................................................43 

5.1 Device ....................................................................................................................44 

5.1.1 How to Control a Local PLC .........................................................................45 

5.1.2 How to Control a Remote PLC .....................................................................50 

5.1.3 How to Control a Remote HMI ......................................................................52 

5.2 Model ......................................................................................................................54 

5.3 General ...................................................................................................................57 

5.4 System Setting .......................................................................................................60 

5.5 Security ..................................................................................................................63 

5.5.1 General mode ...............................................................................................63 

5.5.2 Enhanced security mode ..............................................................................65 



                                                              EasyBuilder User Manual 

 
 

2 

5.6 Font ........................................................................................................................67 

5.7 Extended Memory ..................................................................................................69 

5.8 Printer/Backup Server ............................................................................................71 

5.9 e-Mail ......................................................................................................................73 

5.10 Recipes ................................................................................................................75 

Chapter 6 Window Operations .............................................................................................77 

6.1 Window Types ........................................................................................................77 

6.1.1 Base Window ...............................................................................................77 

6.1.2 Fast Selection Window .................................................................................77 

6.1.3 Common Window .........................................................................................78 

6.1.4 System Message Window ............................................................................78 

6.2 Create, Set, and Delete a Window .........................................................................80 

6.2.1 Creating and Setting a Window ....................................................................80 

6.2.2 Open, Close and Delete a Window ..............................................................83 

Chapter 7 Event Log ............................................................................................................84 

7.1 Event Log Management .........................................................................................84 

7.1.1 Excel Editing .................................................................................................86 

7.2 Create a New Event Log ........................................................................................87 

7.2.1 Event (Alarm) Log General Settings .............................................................87 

7.2.2 Event (Alarm) Log Message Settings ...........................................................89 

7.2.3 Event (Alarm) Log e-Mail Settings ................................................................91 

Chapter 8 Data Sampling ....................................................................................................92 

8.1 Data Sampling Management ..................................................................................92 

8.2 Create a New Data Sampling .................................................................................93 

Chapter 9 Object General Properties ..................................................................................98 

9.1 Selecting the PLC ...................................................................................................98 

9.1.1 Setting Read and Write Address ..................................................................98 

9.2 Using Shape Library and Picture Library ..............................................................101 

9.2.1 Settings of Shape Library ...........................................................................102 

9.2.2 Settings of Picture Library ..........................................................................105 

9.3 Setting Label Text .................................................................................................107 

9.4 Adjusting Profile Size ............................................................................................111 

9.5 Variables of Station Number .................................................................................112 

9.6 Broadcast Station Number ...................................................................................114 

Chapter 10 User Password and Object Security ...............................................................115 

10.1 User Password and Operable Object Classes....................................................115 

10.1.1 General Mode ...........................................................................................115 

10.1.2 Enhanced Security Mode .........................................................................116 



                                                              EasyBuilder User Manual 

 
 

3 

10.2 Enhanced Security Mode and Control Address ..................................................117 

10.2.1 Control Address Settings ..........................................................................117 

10.2.2 Commands ...............................................................................................118 

10.2.3 Command Execution Results ...................................................................119 

10.3 Enhanced Security Mode-related Usage ............................................................120 

10.3.1 Importing User Accounts ..........................................................................120 

10.3.2 Login with USB Security Key ....................................................................122 

10.3.3 Login / Logout Automatically with USB Security Key ................................124 

10.3.4 Enhanced Security Mode with Option List Object .....................................125 

10.4 Object Security Settings .....................................................................................126 

10.5 Example of Object Security Settings ..................................................................127 

Chapter 11 Index Register .................................................................................................130 

11.1 Introduction .........................................................................................................130 

11.2 Examples of Index Register ................................................................................131 

Chapter 12 Keyboard Design and Usage ..........................................................................134 

12.1 Steps to Design a Popup Keyboard ....................................................................135 

12.2 Steps to Design a Keyboard with Direct Window................................................138 

12.3 Steps to Design a Fixed Keyboard on Screen ....................................................140 

12.4 Steps to Design a UNICODE Keyboard .............................................................141 

Chapter 13 Objects ............................................................................................................142 

13.1 Bit Lamp .............................................................................................................143 

13.2 Word Lamp .........................................................................................................146 

13.3 Set Bit .................................................................................................................151 

13.4 Set Word ............................................................................................................155 

13.5 Function Key.......................................................................................................165 

13.6 Toggle Switch .....................................................................................................173 

13.7 Multi-State Switch ...............................................................................................176 

13.8 Slider ..................................................................................................................180 

13.9 Numeric Input and Numeric Display ...................................................................184 

13.10 ASCII Input and ASCII Display .........................................................................193 

13.11 Indirect Window ................................................................................................197 

13.12 Direct Window ..................................................................................................202 

13.13 Moving Shape ...................................................................................................205 

13.14 Animation .........................................................................................................211 

13.15 Bar Graph .........................................................................................................216 

13.16 Meter Display ....................................................................................................222 

13.17 Trend Display ...................................................................................................230 

13.18 History Data Display .........................................................................................244 



                                                              EasyBuilder User Manual 

 
 

4 

13.19 Data Block Display ...........................................................................................252 

13.20 XY Plot .............................................................................................................262 

13.21 Alarm Bar and Alarm Display............................................................................271 

13.22 Event Display ....................................................................................................275 

13.23 Data Transfer (Trigger-based) ..........................................................................284 

13.24 Backup .............................................................................................................286 

13.25 Media Player.....................................................................................................292 

13.26 Data Transfer (Time-based) .............................................................................300 

13.27 PLC Control ......................................................................................................303 

13.28 Schedule ..........................................................................................................312 

13.29 Option List ........................................................................................................330 

13.30 Timer ................................................................................................................337 

13.31 Video In ............................................................................................................341 

13.32 System Message ..............................................................................................345 

13.33 Recipe View......................................................................................................348 

13.34 Flow Block ........................................................................................................353 

13.35 Operation Log Printing ......................................................................................358 

13.36 Circular Trend Display ......................................................................................364 

Chapter 14 Shape Library and Picture Library ...................................................................374 

14.1 Creating Shape Library .......................................................................................374 

14.2 Creating Picture Library ......................................................................................385 

Chapter 15 Label Library and Multi-Language ...................................................................392 

15.1 Introduction .........................................................................................................392 

15.2 Building Label Library .........................................................................................394 

15.3 Setting Label Font ..............................................................................................395 

15.4 Using Label Library .............................................................................................396 

15.5 Settings of Multi-Language (System Register LW-9134) ....................................397 

Chapter 16 Address Tag Library ........................................................................................400 

16.1 Building Address Tag Library ..............................................................................400 

16.2 Using Address Tag Library ..................................................................................402 

Chapter 17 Transferring Recipe Data ................................................................................403 

17.1 Updating Recipe Data with Ethernet or USB Cable ............................................404 

17.2 Updating Recipe Data with SD Card or USB Disk ..............................................405 

17.3 Transferring Recipe Data ...................................................................................406 

17.4 Saving Recipe Data Automatically ......................................................................406 

Chapter 18 Macro Reference ............................................................................................407 

18.1 Instructions to use the Macro Editor ...................................................................407 

18.2 Macro Construction ............................................................................................416 



                                                              EasyBuilder User Manual 

 
 

5 

18.3 Syntax ................................................................................................................417 

18.3.1 Constants and Variables ..........................................................................417 

18.3.1.1 Constants .......................................................................................417 

18.3.1.2 Variables ........................................................................................417 

18.3.2 Operators .................................................................................................419 

18.4 Statement ...........................................................................................................422 

18.4.1 Definition Statement .................................................................................422 

18.4.2 Assignment Statement .............................................................................422 

18.4.3 Logical Statements ...................................................................................422 

18.4.4 Selective Statements ................................................................................424 

18.4.5 Iterative Statements .................................................................................426 

18.4.5.1 for-next Statements ........................................................................426 

18.4.5.2 while-wend Statements ..................................................................427 

18.4.5.3 Other Control Commands ..............................................................428 

18.5 Function Blocks ..................................................................................................429 

18.6 Built-In Function Block ........................................................................................432 

18.6.1 Mathematical Functions ............................................................................432 

18.6.2 Data Transformation .................................................................................437 

18.6.3 Data Manipulation ....................................................................................443 

18.6.4 Bit Transformation ....................................................................................446 

18.6.5 Communication ........................................................................................448 

18.6.6 String Operation Functions .......................................................................465 

18.6.7 Recipe Query Function .............................................................................491 

18.6.8 Miscellaneous ...........................................................................................494 

18.7 How to Create and Execute a Macro ..................................................................501 

18.7.1 How to Create a Macro.............................................................................501 

18.7.2 Execute a Macro ......................................................................................504 

18.8 User Defined Macro Function .............................................................................506 

18.8.1 Import Function Library File ......................................................................507 

18.8.2 How to Use Macro Function Library .........................................................508 

18.8.3 Function Library Management Interface ...................................................510 

18.8.3.1 Create a Function ...........................................................................511 

18.8.3.2 Delete a Function ...........................................................................513 

18.8.3.3 Modify a Function ...........................................................................514 

18.8.3.4 Import a Function ...........................................................................515 

18.8.3.5 Export a Function ...........................................................................516 

18.9 Some Notes about Using the Macro ...................................................................517 

18.10 Use the Free Protocol to Control a Device .......................................................518 



                                                              EasyBuilder User Manual 

 
 

6 

18.11 Compiler Error Message ...................................................................................524 

18.12 Sample Macro Code .........................................................................................530 

18.13 Macro TRACE Function ....................................................................................535 

18.14 Example of String Operation Functions ............................................................542 

18.15 Macro Password Protection ..............................................................................553 

Chapter 19 Configure HMI as a MODBUS Server .............................................................554 

19.1 Configure HMI as a MODBUS Device ................................................................554 

19.1.1 Creating a MODBUS Server  ...........................................................555 

19.1.2 Access a MODBUS Server  ..............................................................558 

19.2 Changing MODBUS Server Station Number in Runtime ....................................561 

19.3 About MODBUS Address Type ..........................................................................562 

Chapter 20 How to Connect a Barcode Reader ................................................................563 

20.1 How to Connect with a Barcode Reader .............................................................563 

Chapter 21 Ethernet Communication and Multi-HMI Connection ......................................567 

21.1 HMI to HMI Communication ...............................................................................568 

21.2 PC to HMI Communication .................................................................................569 

21.3 Operate the PLC Connected with Other HMI .....................................................570 

Chapter 22 System Reserved Words / Bits .......................................................................571 

22.1 The Address Ranges of Local HMI .....................................................................572 

22.1.1 Bits ...........................................................................................................572 

22.1.2 Words .......................................................................................................573 

22.2 HMI Time ............................................................................................................574 

22.3 User Name and Password ..................................................................................575 

22.4 Data Sampling ....................................................................................................576 

22.5 Event Log ...........................................................................................................577 

22.6 HMI Operation ....................................................................................................579 

22.7 Local HMI Network Information ..........................................................................580 

22.8 Recipe and Extended Memory ...........................................................................581 

22.9 Storage Space Management ..............................................................................583 

22.10 Touch Position ..................................................................................................584 

22.11 Station Number Variables .................................................................................585 

22.12 Index Register ..................................................................................................587 

22.13 Project File Information .....................................................................................589 

22.14 MODBUS Server Communication ....................................................................590 

22.15 Communication Parameter Settings .................................................................592 

22.16 Communication Status with PLC (COM) ..........................................................595 

22.17 Communication Status with PLC (Ethernet) .....................................................597 

22.18 Communication Status with PLC (USB) ...........................................................600 



                                                              EasyBuilder User Manual 

 
 

7 

22.19 Communication Status with PLC (CAN Bus) ....................................................601 

22.20 Communication Status with Remote HMI .........................................................602 

22.21 Communication Status with Remote PLC .........................................................608 

22.22 Communication Error Messages & No. of Pending Cmd. .................................611 

22.23 Miscellaneous Functions ..................................................................................612 

22.24 Remote Print/Backup Server ............................................................................614 

22.25 EasyAccess ......................................................................................................615 

22.26 Pass-Through Settings .....................................................................................616 

22.27 Disable PLC No Response Dialog Box .............................................................617 

22.28 HMI and Project Key .........................................................................................618 

22.29 Fast Selection Window Control.........................................................................619 

22.30 Input Object Function .......................................................................................620 

22.31 Local/Remote Operation Restrictions ...............................................................621 

22.32 VNC Control .....................................................................................................622 

Chapter 23 HMI Supported Printers ..................................................................................623 

23.1 The Supported Printer Types .............................................................................623 

23.2 How to check the Supported HP Printer Types ..................................................626 

23.3 How to Add a New Printer and Start Printing ......................................................629 

23.3.1 Add Printer Type ......................................................................................629 

23.3.2 Start Printing .............................................................................................630 

Chapter 24 Recipe Editor ..................................................................................................631 

24.1 Introduction .........................................................................................................631 

24.2 Recipe / Extended Memory Editor Setting ..........................................................631 

24.3 Recipe Records ..................................................................................................634 

Chapter 25 EasyConverter ................................................................................................637 

25.1 How to Export DTL or EVT file to Excel ..............................................................637 

25.2 Scaling Function .................................................................................................639 

25.3 How to Use Multi-File Conversion ......................................................................641 

Chapter 26 EasyPrinter .....................................................................................................642 

26.1 Using EasyPrinter as a Printer Server ................................................................643 

26.1.1 Setup Procedure in EasyPrinter ...............................................................643 

26.1.2 Setup Procedure in EasyBuilder ...............................................................644 

26.2 Using EasyPrinter as a Backup Server ...............................................................647 

26.2.1 Setup Procedure in EasyPrinter ...............................................................647 

26.2.2 Setup Procedure in EasyBuilder ...............................................................648 

26.3 EasyPrinter Operation Guide ..............................................................................652 

26.3.1 Appearance ..............................................................................................652 

26.3.2 Operation Guide .......................................................................................653 



                                                              EasyBuilder User Manual 

 
 

8 

26.4 Convert Batch File ..............................................................................................658 

26.4.1 The Default Value of Convert Batch File ..................................................658 

26.4.2 Specialized Criteria ..................................................................................659 

26.4.3 The Format of a Convert Batch File .........................................................660 

26.4.4 The Order of Examining Criterion .............................................................660 

Chapter 27 EasySimulator .................................................................................................661 

27.1 Prepare Needed Files .........................................................................................661 

27.2 Set the Content of ñxob_pos.defò ........................................................................662 

Chapter 28 Multi-HMI Communication (Master-Slave Mode) ............................................663 

28.1 How to Create a Project of Master HMI ..............................................................664 

28.2 How to Create a Project of Slave HMI ................................................................665 

28.3 How to Connect with MT500 Slave HMI .............................................................668 

Chapter 29 Pass-through Function ....................................................................................671 

29.1 Ethernet Mode ....................................................................................................672 

29.1.1 How to install virtual serial port driver .......................................................672 

29.1.2 How to Change the Virtual Serial Port ......................................................673 

29.1.3 How to Use Ethernet Mode ......................................................................674 

29.2 COM Port Mode ..................................................................................................677 

29.2.1 Settings of COM Port Mode ......................................................................677 

29.2.2 HMI Work Mode .......................................................................................679 

29.3 Using System Registers to Enable Pass-Through ..............................................680 

Chapter 30 Project Protection ............................................................................................682 

30.1 EXOB Password .................................................................................................683 

30.2 Decompilation is Prohibited ................................................................................684 

30.3 Disable EXOB Upload Function ..........................................................................685 

30.4 Project Key .........................................................................................................686 

30.5 EMTP Password .................................................................................................687 

Chapter 31 Memory Map Communication .........................................................................688 

31.1 Introduction .........................................................................................................688 

31.2 PIN Settings........................................................................................................688 

31.3 Communication Flowchart ..................................................................................689 

31.4 Address Types ....................................................................................................691 

31.4.1 Communication Examples ........................................................................692 

31.5 Settings ..............................................................................................................694 

31.5.1 Add a Memory Map Device ......................................................................694 

31.5.2 Object Settings .........................................................................................697 

31.5.3 Execute the Settings ................................................................................699 

Chapter 32 FTP Server Application ...................................................................................700 



                                                              EasyBuilder User Manual 

 
 

9 

32.1 Login FTP Server ...............................................................................................700 

32.2 Backup History Data and Update Recipe Data ...................................................702 

Chapter 33 EasyDiagnoser ................................................................................................704 

33.1 Overview and Configuration ...............................................................................704 

33.2 EasyDiagnoser Settings .....................................................................................707 

33.3 Error Code ..........................................................................................................713 

33.4 Save As ..............................................................................................................714 

33.5 Window Adjustment ............................................................................................715 

Chapter 34 Rockwell EtherNet/IP Free Tag Names ..........................................................716 

34.1 Import User-Defined AB Tag CSV File to EasyBuilder .......................................717 

34.2 Adding a New Data Type ....................................................................................719 

34.3 Paste ..................................................................................................................722 

34.4 Miscellaneous .....................................................................................................724 

34.5 Module-Defined ..................................................................................................728 

Chapter 35 EasyWatch ......................................................................................................732 

35.1 Overview ............................................................................................................732 

35.2 Basic Functions ..................................................................................................733 

35.2.1 Basic Functions ........................................................................................733 

35.2.2 Quick Selection Tools ...............................................................................734 

35.3 Monitor Settings ..................................................................................................735 

35.3.1 Add Monitor ..............................................................................................735 

35.3.2 Monitor Settings .......................................................................................736 

35.3.3 Add a New Device ....................................................................................737 

35.4 Macro Settings ....................................................................................................742 

35.4.1 Add Macro ................................................................................................742 

35.4.2 Macro Settings .........................................................................................743 

35.4.3 Add New Macro Settings ..........................................................................744 

35.5 HMI Manager ......................................................................................................746 

35.5.1 HMI Settings .............................................................................................746 

35.5.2 HMI Manager ............................................................................................747 

35.6 Object List ..........................................................................................................748 

35.6.1 Page Settings ...........................................................................................748 

35.6.2 Columns of Object List .............................................................................749 

Chapter 36 Administrator Tools .........................................................................................750 

36.1 Overview ............................................................................................................750 

36.2 User Accounts ....................................................................................................751 

36.2.1 Introduction of User Accounts ..................................................................751 

36.2.2 Setting User Accounts ..............................................................................753 



                                                              EasyBuilder User Manual 

 
 

10 

36.2.3 Import accounts via EasyBuilder ..............................................................755 

36.3 USB Security Key ...............................................................................................756 

36.3.1 Introduction of USB Security Key .............................................................756 

36.3.2 Setting USB Security Key .........................................................................757 

36.3.3 EasyBuilder USB Security Key Settings ...................................................758 

36.4 e-Mail SMTP Server Settings .............................................................................759 

36.4.1 Introduction of e-Mail SMTP Server Settings ............................................759 

36.4.2 e-Mail SMTP Server Settings ...................................................................760 

36.5 e-Mail Contacts ...................................................................................................761 

36.5.1 Introduction of e-Mail Contacts .................................................................761 

36.5.2 e-Mail Contacts Settings...........................................................................763 

36.5.3 Use EasyBuilder to Import e-Mail Settings and Contacts .........................765 

Chapter 37 Operation Log .................................................................................................766 

37.1 Introduction ........................................................................................................766 

37.2 Operation Log Settings ......................................................................................767 

37.3 Operation Log View ...........................................................................................770 

37.4 Demonstration ....................................................................................................773 

37.5 Uploading Operation Log ...................................................................................774 

Appendix 1 Comparison of HMI Software Functions .........................................................776 

 

 



                                               EasyBuilder Installation and Startup Guide 

 
 

11 

 

Chapter 1 EasyBuilder Installation and Startup Guide 

 

1.1 EasyBuilder Installation 

 

Software: 

Download EasyBuilder from CD or visit Weintek Labs, Inc.ôs website at 

http://www.weintek.com. The language versions include Simplified Chinese, Traditional 

Chinese, English, Italian, Korean, Spanish, Russian, and French. The latest upgraded files 

can be downloaded too. 

 

Hardware Requirements (Recommended):  

CPU: INTEL Pentium II or higher 

Memory: 256MB or higher 

Hard Disk: 2.5GB or higher (Disc space available at least 500MB) 

CD-ROM: 4X or higher 

Display: 1024 x 768 resolution or greater 

Keyboard and Mouse 

Ethernet: for project downloading/uploading 

USB Port 2.0: for project downloading/uploading 

RS-232 COM: for on-line simulation  

Printer 

  

Operating System: 

Windows XP / Windows Vista / Windows 7. 

 

http://www.weintek.com/
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1.2 Steps to Install EasyBuilder 

 

1. Installing EasyBuilder: 

Put the disk into the CD drive. The computer will run the program automatically or execute 

under the root directory [Autorun.exe] manually. The installation screen is shown below. 

 

 

2. Click [Install], the dialog below is shown, select the language and click [Next].  

 

 

 

 

 

 

EnglishϣSpanishϣFrenchϣItalianϣ

Simplified ChineseϣTraditional 

ChineseϣKoreanϣRussian. 
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3. To remove the old versions of EasyBuilder, please select the check box and click [Next]. 
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4. Designate a new folder for EasyBuilder installation or use the folder recommended and 

then click [Next]. 

 

5. Select a start menu folder to save the programôs shortcuts. Click [Browse] to designate a 

folder or use the folder recommended then click [Next]. 
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6. Users will be enquired if there are any additional tasks to be done. For example: [Create a 

desktop icon]. Select it if needed then click [Next] to continue. 

 

7. When finish settings, please check if they are all correct. If any changes need to be made, 

click [Back] to change the settings or click [Install] to start installing. 
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8. Installation processing. 

 

 

9. Click [Finish] to complete the installation. 
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10. The EasyBuilder shortcuts can be found in [Start] » [All Programs] » [EasyBuilder]. 

 

 

The description of each item in EasyBuilder menu: 

Installed file Description 

Administrator 
Tool 

Save the data of User Accounts, USB Security Key, e-Mail SMTP 
Server Setting, e-Mail Contacts to USB disk and import to HMI. 

EasyBuilder Pro EasyBuilder project editor. 

EasyConverter Conversion tool for Data Sampling and Event Log. 

EasyDiagnoser Tool for detecting the connection between HMI and PLC. 

EasyPrinter Remote screen hardcopy and backup server. 

EasySimulator Execute simulation without installing EasyBuilder. 

EasyWatch Via PC to monitor or set HMI and PLC address value. 

Recipe Editor 
Tool for setting the format of Recipe data. Users can open Recipe 
data or data in the External Memory here. 

Release Note Software release notes. 

Structure Editor 
Supports AB TAG and improve the flexibility to read / write an 
object. 

Utility Manager EasyBuilder Pro managing tool. 

 

 

ƴ HMI support downloading/uploading projects via USB cable. After installing EasyBuilder, 

please go to [Computer Management] » [Device Manager] to check if USB driver is installed, 

if not, please install it manually. 
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Chapter 2 Utility Manager 

 

After installing EasyBuilder, double click [Utility Manager] shortcut on the desktop to start. 

Utility Manager is for launching several utilities and it is a stand-alone program. 

To launch EasyWatch, Administrator Tools, and Recipe Database Editor, please open 

EasyBuilder first. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Launch EasyBuilder 
to edit projects. 

After rebooting, the 
system returns to the 
initial condition. 

Conversion tool for 
Data Sampling/ 
Event Log. 

Remote printer 
/backup server. 

Extended Memory 
and recipe editing. 

Review the address 
ranges and formats of 
supported PLCs. 

On-line monitoring 
and debugging tool. 

Save the data in 
SD/USB to download 
to HMI. 

Allow other PC 
applications to 
connect PLC via 
HMI. 

Connect via USB 
cable or Ethernet to 
check the HMI history 
files information. 
 

Set password here 
before operating HMI 
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2.1 HMI IP, Password  

 

[Settings] 

When operating HMI via 

Ethernet or USB cable, 

please set the password 

for HMI to protect against 

unauthorized access. 

 

[Reset / Download] functions share the same password while [Upload] function uses 

another one. 

 

Â Please remember the password, otherwise, while restoring HMI default settings, the 

project files and data in HMI will be completely erased. 

 

[Reboot HMI] 

Reboot the HMI without unplugging. After 

reboot, the system returns to the initial state. 

Set the correct IP address when rebooting 

HMI via Ethernet. 

 

[Data/Event Log File Information] 

BAfter setting, connect with HMI to check the 

number of history files in HMI. 
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2.2 Editing Tools 

 

2.2.1 Build Download Data for Saving in SD Card or USB Disk 

 

 

 

1. Insert the external device (SD card or USB disk) to PC. 

2. Assign the folder to store data. 

3. Select source files for project, recipe (A) and data log. 

4. Select [Build] to create files for downloading. 

 

The source files will be saved in the inserted device for users to download to HMI without 

connecting via a USB cable or Ethernet. 

 

 

 

 

 

 

 

 
77 
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2.2.2 Steps to Download Project to HMI via USB Disk or SD Card 

 

Assume we will download data in the folder named ñ123ò (K:\123) on an USB disk. 

 

1. Insert USB (in which project saved) to HMI. 

2. In [Download / Upload] dialog box select [Download]. 

3. Enter Download Password. 

4. In [Download Settings] dialog box, select [Download project files] and 

[Download history files] check boxes. 

5. Press [OK]. 

6. In [Pick a Directory] dialog box, select directory: usbdisk/device-0/123. 

7. Press [OK]. 

Project will then be updated. 

 

 

Â If only the history files are downloaded, it is necessary to reboot HMI to update files. 
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2.3 Transfer 

 

2.3.1 Download 

Download files to HMI via Ethernet or USB cable. 

 
 

[Firmware] 

Update HMI kernel programs. The firmware must be downloaded at the first time 
downloading data to HMI. 
 

[Project] 

Select an exob file. 

 

[RW / RW_A] 

Select a rcp file. 
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[Recipe database] 

Select a db file of Recipe Database. 

 

[Data log] 

Select a dtl file in datalog folder. Select the data sampling folder in HMI and then select a dtl 

file. 

 

[Startup screen] 

Download a bmp bitmap file to HMI. After HMI is rebooted, this bmp file will be shown before 
project starts. 
 

[Reboot HMI after download] 

Automatically reboot after download. 
 
[Reset recipe] [Reset event log] [Reset data log] [Reset recipe database]  

Erase the selected files in HMI before download. 
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2.3.2 Upload 

Upload files from HMI to PC via Ethernet or USB cable. 

Click [Browse] and assign the file path before uploading. 

 
 

For [Project], [RW / RW_A], [Recipe database] or [Data log], please refer to 2.3.1. 

 

[Event log] 

Upload the evt file in HMI to PC. 

 

[Extended Memory (EM)] 

Upload the emi file saved in SD card or USB disk to PC. 

 

Â The file will be uploaded to PC in exob format. Please decompile it into editable emtp 

file first and open the emtp file in EasyBuilder. 
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2.4 Simulation 

 

2.4.1 Off-line Simulation / On-line Simulation 

 

Off-line simulation: Simulate project operation on PC  

without any connection. 

 

 

On-line simulation: Simulate project operation on PC and 

PLCs are directly connected with PC. 

 

 

 

Â When using [On-line simulation] on PC, if the target device is a local PLC (the PLC is 

directly connected to PC), there is a 10 minutes simulation limit. 

OK without HMI 

&PLC and save 

more time 

No need to 

download project 

to HMI. 

Simulate 
operations without 
connecting PLC. 
 

Connect 
PC-PLC & set 
correct 
parameters to 
operate. 
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Before executing On-line/Off-line Simulation, please select the source *.exob file. 

 

When executing on-line/off-line simulation, right click to use these functions:  

 

[Exit simulation] 

Stop simulating. 

 

[Run EasyDiagnoser]  

To monitor current communication 

status. 

 

[Screenshot]  

Capture and save current screen 

image as a picture file in the 

screenshot folder under the 

installation directory. 
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2.5 Pass-Through 

 

This function allows the PC application to connect PLC via HMI. In this case, the HMI works 

like a converter. 

 

Pass-through provides two modes: [Ethernet] and [COM port].  

When using [Ethernet], please install the virtual serial port driver first. 

 

 

For more detail, please refer to ñChapter 29 Pass Through Functionò. 
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Chapter 3 Create an EasyBuilder Pro Project 

The following is the process of creating a project. 

 

 

 

3.1 Create a New Project 

 

1. Launch EasyBuilder. 

2. Open a new file. 

3. Select [Model]. 

4. Tick [Use 

template]. 

5. Click [OK]. 

6. Click [New]. 

7. Configure 

parameters. 

8. Click [OK]. 

 

9. A new device is added 

to the [Device List]. 

 

 

 

Save & 

Compile 

Download 

to HMI 

 

On-line 
Off-line 
Simulation 

Create a 

Project 
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Now letôs add a new object. 

 

1. Create a Toggle Switch Object. 

2. Set address. 

 

 

3. Place the object in the edit window. 

4. A project is now created. 
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3.2 Save and Compile the Project 

 

In EasyBuilder toolbar: 

 

 

 

 

 

 

 

 

 

 

 

 

To use multiple languages, all languages must be configured in [Label Tag Library] first. 

When downloading the project to HMI, select the needed languages only. At most 8 

languages can be selected. 

A successful compilation is shown below: 

 

 

 

2. Click [Compile] to compile emtp 

file as exob file, which could be 

downloaded to HMI. This also 

checks if the project can run 

correctly. 

1. Click [Save] to save 

the emtp file. 
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3.3 Off-line and On-line Simulation 

 

 

 

 

 

On-line simulation - Simulate project operation on PC 

 

 

 

 

 

 

When using [On-line Simulation] on PC, if the target device is a local PLC (i.e. the PLC 
directly connected to PC), there is a 10-minute simulation limit. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Simulate on PC 

without download ï  

Ing project. 

Connect 
PC-PLC & set 
correct 
parameters. 

Off-line simulation - Simulate project operation on PC 
Without HMI & 

PLC and save 

more time. 

Simulate 
operations 
without 
connecting PLC. 
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3.4 Download the Project to HMI 

 

< Way 1 [Ethernet] » HMI IP 

 

Before [Download], 

make sure that all the 

settings are correct. 

 

 

 

 

 

Set [Password] & 

Specify [HMI IP]. 

 

[Firmware] 

Select the check box to 

update the HMI kernel 

programs. If this is the 

first time downloading 

file or EasyBuilder 

version is updated, 

please download the 

firmware before 

downloading files to 

HMI. 

 

[Font files] 

Download the font 

used in the project. 

 

 

 

 

[Reset recipe] [Reset recipe database] [Reset event log] [Reset data sampling] 

The selected files will be erased before downloading. 

 

[Reboot HMI after download] 
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HMI will reboot after the downloading process is done. 

 

[Automatically using current settings to download after compiling] 

The system will compile the project and download it to the latest target HMI. 

The way to enable this function: 

 

 

 

 

 

 

 

 

 

1. Click [Function Properties]. 

2. Select [Automatic save and compile when download and simulate] check box. 

 

 

 

 

 

3. [Save] the project. 

4. Click [Download] to download 

the project to HMI. 

5. In the dialog box, select 

[Automatically using current 

settings to download after 

compiling] check box. 

6. Click [Download]. 

7. After [Download] finished, next 

time when [Download] is 

clicked, EasyBuilder will 

automatically compile and 

download the project to the latest target HMI. 

2. Tick 
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< Way 2 [Ethernet] » HMI Name 

1. Go to [System settings] on HMI and then set HMI name first. 

 

2. On PC, select the HMI name and start downloading.

4

. 

Enter the HMI name to search for 

the HMI. 

Search for the HMIs in the same 

subnet network. 
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< Way 3 [USB Cable] 

 

 

 

 

 

Select USB cable to 

download project to HMI. 

The way of setting is 

same as Way 1 

mentioned above.  

 

 

 

 

 

 

 

 

 

 

 

 

 

ƴ Before downloading via USB cable, please make sure the USB driver is installed. Go to 

[Computer Management] » [Device Manager] to check if USB driver is installed. If it is not 

installed, please refer to installation steps to install manually. 

 

4

. 

ftp://ftp.weintek.com/MT8000/eng/FAQ/FAQ_29_How_to_install_USB_driver_of_HMI_i_series.pdf
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< Way 4 [USB Disk / SD Card] 

1. In Utility Manager / Project 

Manager, click [Build Download 

Data for SD / USB Disk] to build 

the data to be downloaded first. If 

configured as shown on the left, it 

would generate 2 directories: 

 

2. Insert an external device, such as SD card or 

USB disk to HMI.  

3. Select [Download] and enter password. 

4. After password is confirmed, it will show the 

directories in the external device. (pccard: SD 

Card; usbdisk: USB Disk) 

5. Select the directory that stores project. Then 

click [OK] to start downloading. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

Please select the parent directory of the generated files when downloading. For the 

structure above, please select Download, not eMT3000 or history.  

4

. 

(The history directory is generated 

when downloading history data.) 
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Chapter 4 Hardware Settings 
 

4.1 I/O Ports 

 

The I/O ports are different from one HMI type to another.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In addition, Weintek provides [FLZ232000 Multi-Connector Cable] and [FLZ485000 

Multi-Connector Cable] to expand the COM port for easier operation. 

 

 
Supports USB devices, such as 
mouse, keyboard, USB disk, printer, 
or barcode device. 

 
Connects to Ethernet devices, such 
as PLC, laptop. 

 
Download / Upload project via SD 
card, including recipe transfer, event 
log, data logéetc and to backup or 
record history data. 

 
Connects PLC or other peripheral 
devices. 
RS-232 / RS-485 2W/4W 
CAN Bus. 
 

 

 
Download / Upload project including 
recipe transfer, event log, data 
logéetc. 
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4.2 System Settings 

For the first time operating HMI, please complete the following system settings. When 

finished, the project files designed using EasyBuilder can be used on HMI. 

 

4.2.1 System Reset 

Each HMI is equipped with a reset button and a DIP switch. When using DIP switch to 

change modes, the 

corresponding functions will 

be triggered. 

If system password is lost or 

forgotten, please flip DIP 

Switch 1 to ON and the rest to 

OFF, and then reboot HMI.  

 

HMI will switch to touch 

screen calibration mode. 

 

 

1. A ñ+ò sign appears on the screen, touch the center 
of the sign, after all 5 signs are touched, ñ+ò 
disappears and the touch screen parameters will be 
stored in HMI system.  
 
 
 
 
 
 
2. After calibration, confirm to restore the default 
password, select [Yes]. 
 
 
 

 
 
 
3. Confirm to restore the default password again by 
typing [yes] and clicking [OK]. The project files and 
history records stored in HMI will all be removed. (The 
default local password is 111111. However, other 
passwords, such as download/upload passwords have 
to be reset.) 
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Â Dip Switch 4 is set ON or OFF according to the LCD used. If it should be ON when out 

from factory, the Dip Switch 4 would be set ON and cut off. If it should be OFF, the Dip 

Switch 4 would be set OFF but the switch is not cut. 

Â The mTV Series only provides DIP Switch 1 and 2. The corresponding functions are 

listed below. 

mTV 

 

 

SW1 SW2 Mode 

ON ON Restore factory default 

ON OFF Hide system toolbar 

OFF ON Boot loader mode 

OFF OFF Normal 

 

4.2.2 System Toolbar 

After rebooting HMI, users can set the system with [System Toolbar] at the bottom of the 

screen. Normally, this bar is hidden automatically. Only by touching the target at the 

bottom-right corner of the screen will the System Toolbar pop up. 

 

 

SW1 SW2 SW3 SW4 Mode 

ON OFF OFF OFF Touch screen calibration mode 

OFF ON OFF OFF Hide system toolbar 

OFF OFF ON OFF Boot loader mode  

OFF OFF OFF ON Reserved 

OFF OFF OFF OFF Normal 

Text Keyboard            Number Keyboard 
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ƴ How to hide HMI System Setting Toolbar 

When [DIP Switch 2] is set ON, the system setting toolbar is disabled. When set OFF; the 

system setting toolbar is enabled. Please restart HMI to enable/disable the toolbar.  

System register [LB-9020] can also enable/disable system setting toolbar 

When [LB-9020] is set ON, the toolbar is displayed, and set OFF to hide the toolbar. 

For mTV Series, flip DIP Switch 1 to ON to hide system setting toolbar. 

  

4.2.3 System Information 

Network: Displays network information & HMI IP.  Version: Displays HMI system version. 

 

4.2.4 System Setting 

Set or modify system parameters. 
Confirm password for security. 

 

 

 

 

 

 

 

 

 

 

 

 

 

ƴ Network 
Download project to HMI via Ethernet. 
Confirm IP address of target HMI. 
[Obtain an IP Address Automatically] or 
[IP address get from below]. 

+  
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ƴ Security 

Password protection, the default is 111111. 

 

 
[Password for entering system]  
[Password for uploading project] 
[Password for downloading project] 
[Password for uploading history data] 
 
Password confirmation dialog: 

 

 

 

 

 

 

 

 

ƴ Time/Date  
Setting HMI local time/date. 

 

 

ƴ Miscellaneous 
Rotary switch for adjusting LCD brightness.  

 

 

ƴ History 
Clears history data in HMI. 
[Recipe] / [Eventlog] / [Datalog] 

 

 

ƴ Firmware setting 
Upgrades firmware / enable portrait mode.  
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ƴ HMI name 

Set HMI name to download/upload project. 

 

 

ƴ VNC server 
Remote HMI monitoring and controlling via 
Ethernet.  

 

Step 1. Enable HMI VNC server, set 

password. 

Step 2. Install Java IE or VNC Viewer on 

PC. 

Step 3-1 Input remote HMI IP in Java IE.  

Step 3-2 In VNC Viewer input remote HMI 

IP and password. 

 

 

 

Â One HMI allows only one user to log in 

VNC server at one time. If there is no 

activity for more than one hour, HMI 

system will log out automatically. 

Â The mTV Series does not support VNC 

server.
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Chapter 5 System Parameter Settings 

 

Launch EasyBuilder, in the main menu select [Edit] » [System Parameters] to open the 

[System Parameter Settings] dialog: 

 

 

 

System Parameter Settings are divided into several parts: [Device], [Model], [General], 

[System Setting], [Security], [Font], [Extended Memory], [Printer/Backup Server], 

[e-Mail] and [Recipes]. 

These will be introduced respectively in this chapter. 
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5.1 Device 

 

Parameters in this tab determine the attributes of each device connected with HMI. The 

device can be a Local / Remote HMI / PLC.  

When creating a new project file, there is a default device "Local HMI" which indicates the 

HMI that will be updated and programmed. To change the relevant device settings, click 

[System Parameter Settings] » [Settings] to open [Device Properties] dialog as shown 

below: 
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5.1.1 How to Control a Local PLC 

 

 

ñLocal PLCò means the PLC is connected to the local HMI. To control/connect a Local PLC, 

add this type of device first. Click [System Parameter Settings] » [New] to open [Device 

Properties] dialog as shown below: 

 

For example, we want to connect ñMitsubishi FX0s/FX0n/FX1s/FX1n/FX2ò as a Local PLC: 

 

 

The settings are described below: 

Setting Description 

Name The name of the device. 

HMI / PLC In this example the device used is a PLC, so select [PLC]. 

Location Select [Local] or [Remote]. In this example the PLC is connected to the 

Local HMI, so select [Local]. 
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PLC type Select the type of the PLC. 

PLC I/F The available PLC interface: [RS-232], [RS-485 2W], [RS-485 4W], 

[Ethernet], and [USB]. 

 

If the interface used is [RS-232], [RS-485 2W], or [RS-485 4W], configure 

communication parameters by clicking [Device Properties] » [Settings] 

and then [Com Port Settings] dialog opens, as shown below: 

 

 

[Timeout] 

If the communication has been disconnected for more than preset time limit 

configured in [Timeout] (in sec), Window No. 5 will pop up and show ñPLC 

No Responseò message, as shown below: 

 

[Turn around delay] 

While sending the next command to PLC, HMI will delay the sending 

according to the time interval set in [Turn around delay]. This may 

influence the efficiency of the communication between HMI and PLC. 

Default value is ñ0ò. 

Note: If the PLC used is SIEMENS S7-200 Series, it is recommended to 

assign ñ5ò to [Turn around delay] and ñ30ò to [Send ACK delay]. 

 

If the interface used is [Ethernet], click [Device Properties] » [Settings] 

and the [IP Address Settings] dialog opens. Please set correct PLC IP 
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address and port number. For example, use a S7-1200 as the connected 

PLC, as shown below: 

 

If the interface is [USB], no further setting is required. Please check the 

settings in [Device Properties]. 

 

If the interface is [CAN (Controller Area Network) Bus], please check the 

PLC connect guide for ñCANopenò and import the eds device file. 

PLC default 

station no. 

The default station number for PLC address if the PLC station number is not 

included in the address, as explained later. 

 

PLC station no. can be set in PLC address. The address format: 

ABC#DEFGH 

ABC stands for PLC station number and ranges from 0 to 255. DEFGH 

stands for PLC address. And the ñ#ò sign separates the station number and 

the address. As shown below, the data is read from PLC station number 1, 

and address T20. 
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Default 

station no. 

use station 

no. variable 

Use the station number variables as the default PLC station number. Select 

one from LW-10000 to LW-10015 as the station number variables. If the 

station no. is not specified in PLC address, the station number will be 

determined by the station no. variable.  

For example, if var7 is set for default station no: 

 

The followings demonstrate some examples: 

a. The PLC station number is ñ5ò. 

 

b. The PLC station number is determined by var7 (LW-10007) 

 

c. PLC address is set to ñ111ò, since PLC station no. is not specified, and 

the default station no. is using var3, the PLC station no. is determined by 

var3 (LW-10003). 

 

Use 

broadcast 

command 

When [Use broadcast command] check box is select, please fill in 

[Broadcast station no.] according to the broadcast station number defined 

by PLC. When HMI sends a broadcast command to the station number set 

here, PLC will only receive the command and not reply to HMI. 

 
And set as below: 

 

When HMI sends a command to address 255#200, all the PLCs will receive 

this command and will not reply. 

Note: Only PLCs that support broadcast command can use this function. 
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Interval of 

block pack 

(words) 

If the interval between read addresses of different commands is less than 

this value, the commands can be combined to one. But the combining 

function is disabled if this value is set to ñ0ò. 

 

For example, the interval value is set to ñ5ò, to read 1 word from LW3 and 2 

words from LW6 respectively (read from LW6 to LW7), since the interval of 

addresses between LW3 and LW6 is less than 5, these two commands can 

be combined to one. The result is to read 5 consecutive words from LW3 to 

LW7. 

Note: The maximum size of command combination data must be less than 

[Max. read-command size]. 

Max. read -  
command 
size 
(words) 

The maximum data size to read from the device at one time. Unit: word 

Max. write - 
command 
size 
(words) 

The maximum data size to write to the device at one time. Unit: word. 

 

After all settings are completed, a new device named ñLocal PLC 1ò is added to the [Device 

list]. 

 

 



                                                           System Parameter Settings 
 

 50 

 

5.1.2 How to Control a Remote PLC 

  

ñRemote PLCò is a PLC being connected to a remote HMI. To control a remote PLC, add this 

type of device first. Please click [System Parameter Settings] » [New] to open [Device 

Properties] dialog. For example, use SIEMENS S7-200 as the Remote PLC: 
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The settings are described below: 

Setting Description 

HMI or PLC In this example, the device used is a PLC, so select [PLC]. 

Location Select [Local] or [Remote]. In this example the PLC is connected to 

Remote HMI, so select [Remote]. Set the IP address and port number of 

the Remote HMI by clicking [Settings] next to [Remote]. 

 

PLC Type Select the type of the PLC. 

PLC I/F The interface used for Remote PLC. If the remote PLC uses a COM port, 

select [RS-232], [RS-485 2W], or [RS485 4W]. 

PLC 

default 

station 

no. 

Set the station number of Remote PLC. 

COM Set the COM port used by the Remote PLC, this setting must be correct. 

 

After all settings are completed, a new device named ñRemote PLCò is added to the [Device 

list]. 
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5.1.3 How to Control a Remote HMI 

 

          

 

ñRemote HMIò is the HMI other than ñLocal HMIò, and PC is also a ñRemote HMIò. To control 

a Remote HMI, add this type of device first. Click [System Parameter Settings] » [New] to 

open [Device Properties] dialog as shown below: 
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Setting Description 

HMI or PLC In this example, the device used is a HMI, so select [HMI]. 

Location Select [Local] or [Remote]. In this example Remote HMI is used, select 

[Remote]. Set the IP address and port number of the Remote HMI by 

clicking [Device Properties] » [Settings]. 

 

 

After all settings are completed, a new device named ñDeviceò with ñNo.ò as ñRemote HMI 1ò 

is added to the [Device list]. 
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5.2 Model 

Configure the [HMI model], [Timer], [Printer] and [Scroll bar] settings. 

 

The settings are described below: 

 

Setting Description 

HMI model Select the HMI model to use. 

 

If the HMI model is changed, the [Resize pop-up windows / objects] 

dialog will pop up, as shown below. Select required adjustment and 

click [OK]. In most cases, please select all options. 
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HMI station 

no. 

Set the station number of current HMI. The default value is ñ0ò. 

Port no. Set the port number of current HMI. It is also used in MODBUS TCP 

server. The default value is ñ8000ò. 

Timer [Clock source] 

Set the source device of the clock/time information. It is used by [Data 

Sampling], [Event Log], é., etc.  

a. If [HMI RTC] is selected, the time information comes from the 

internal clock of the HMI. 

b. If [External device] is selected, the time information comes from 

an external device. The address of the source device must set 

correctly. As shown below, the time information is from ñTVò 

address type of the ñLocal PLCò. The addresses of ñTVò start from 0 

and contain 6 consecutive words and each of them store the 

following information: 

TV 0 Ÿ  Second (range: 0~59) 

TV 1 Ÿ  Minute (range: 0~59) 

TV 2 Ÿ  Hour (range: 0~23) 

TV 3 Ÿ  Day (range: 1~31) 

TV 4 Ÿ  Month (range: 1~12) 

TV 5 Ÿ  Year (range: 1970~2037) 
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Printer [Type] 

A printer can be connected with the HMI. For HP PCL Series, it has to 

be connected through USB interface while other printers through a 

COM port. For more information, please refer to ñChapter 23 HMI 

Supported Printersò. 

 

If the printer is connected through [COM], configure the parameters 

correctly. If the printer type is [SP-M, D, E, F], the [pixels of width] 

has to be set accurately, i.e. the set pixel(s) cannot exceed printerôs 

default setting, or the HMI will fail to print data. 

 

Scroll bar [Width] 

Set to [Small], [Middle] or [Large] as required.  

Set the width of Scroll Bar, when the size of the object is too small to 

display the contents, a scroll bar is displayed in the object. 

 



                                                           System Parameter Settings 
 

 57 

 

5.3 General 

 

Configure the properties related to screen display. 
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The settings are described below: 

Setting Description 

Fast 

selection 

button 

Setting the attributes for fast selection button for Window No. 3. To use 

the fast selection button, create Window No. 3 first. 

a. [Attribute] 

 

Enable or disable fast selection window. Select [Enable] and click 

[Settings] to set the attributes, including color and text of the button. 

b. [Position] 

 

Select the button position on the screen. If [Left] is chosen, the button 

will show up in at bottom left side of the screen; if [Right] is chosen, the 

button will show at the bottom right side of the screen 

Screen 

saver 

a. [Back light saver] 

If the screen is left untouched and reaches the time limit set here, the 

back light will be turned off. The unit is minute. Back light will be on again 

once the screen is touched. If [none] is set, the back light will always be 

on. 

b. [Screen saver] 

If the screen is left untouched and reaches the time limit set here. The 

current screen will automatically switch to a window assigned in [Saver 

window no.].The setting unit is minute. If [none] is set, this function is 

disabled. 

c. [Saver window no.] 

To assign a window for screen saver. 

Option a. [Startup window no.] 

Designate the window shown when start up HMI. 

b. [Common window] 

 

The objects in the common window (Window No. 4) will be shown in 

each base window. This determines that the objects in common window 
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are placed above or below the objects in the base window. 

c. [Keyboard caret color] 

Set the color of caret that appears when entering data in [Numeric Input] 

and [Word Input] objects. 

d. [Object layout] 

 

If [Control] mode is selected, when operating HMI, [Animation] and 

[Moving Shape] objects will be displayed above other kinds of objects 

neglecting the sequence that the objects are created. If [Nature] mode is 

selected, the display will follow the sequence that the objects are 

created, the first created will be displayed first. 

e. [RW_A enabled] 

Enable or disable recipe data RW_A. Enable this, the objects can then 

control RW_A .The size of RW_A is 64K. 

Event [Extra no. of events] 

The default number of the events in the system is 1000. For additional 

number of events, modify this setting. The maximal is 10000. 

Keyboard The window number in which the keyboard is placed. When using 

[Numeric Input] or [ASCII Input] objects, the type of keyboards can be 

selected. Up to 32 keyboards can be added. To design a keyboard, a 

window should be designated for creating it. Press [add] after creating, 

and add the window to the list. For more information, please see 

ñChapter 12 Key Pad Design and Usageò  

Project 

protection 

Userôs project can be restricted to be executed by a specific HMI. Please 

refer to ñChapter 30 Project Protectionò for more information. 
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5.4 System Setting 

 

[System Setting] is used to configure different functions of EasyBuilder. 

 

 

Some functions are duplicated from system registers, such as, [Hide system setting bar 

(LB-9020)], [Hide mouse cursor (LB-9018)], [Disable buzzer (LB-9019)], [Prohibit remote 
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HMI connecting to this machine (LB-9044)], and [Disable upload function (LB-9033)]. Users 

can also set these functions via system tag.  

To select a system tag, select [Address] » [System tag] check box when adding a new 

object and then select the [Device Type].  

To browse all the system tags, Select [Library] » [Tag] » [System] from the main menu of 

EasyBuilder. 

[Startup language after redownloading the project] 

Set the language to use when HMI starts after the project is re-downloaded. 

[Execute init. MACRO when power on] 

Designate the macro to be executed when HMI power on. 

[Auto logout] 

If leaving HMI untouched for longer than the set time, the objects protected by security 

classes will not be able to operate. The user ID and password must be entered again to 

unlock it. 

[Hide System Setting Bar] 

Hide the system setting bar in the bottom right corner of the HMI screen.  

[Hide Mouse Cursor] 

Hide the mouse cursor in HMI screen. 

[Disable Buzzer] 

Mute HMI. 

[Prohibit remote HMI connecting to this machine] 

Prohibit the connection with a remote HMI. The remote HMI will not be able to control the 

local HMI. 

[Disable upload function (effective after rebooting HMI) (or set LB9033 ON)] 

Disable HMI to upload project, after downloading, HMI must be rebooted to disable 

uploading project. 

[Prohibit password remote-read operation (or set LB9053 ON)] 

Prohibit Remote HMI to read Local HMI password. 

[Prohibit password remote-write operation (or set LB9054 ON)] 

Prohibit Remote HMI to write Local HMI password. 

[Use a disconnection icon or relative objects when PLC communication fails] 

Decide whether or not to display a disconnection icon on relevant objects when failing to 

communicate with PLC. 
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When using this function and fail to communicate with PLC, this icon will be shown in the 

lower right corner of the object as below: 

 

[VNC Server] 

Set the password to log in VNC server. 

 

[LW protection], [RW protection] 

If select [Disable LW/RW remote-write] check boxes and set the protect range in [LW/RW 

range], values within the protected range cannot be adjusted using Remote HMI. 

 

[Easy Access server] 

Through this technology, users can easily access to any HMI connected to the internet and 

operate them on PC just like holding touch screen in hand.  

Easy Access does not transmit updated graphic images directly but only the real time data. 

This makes transmission really quick and efficient. Please refer to ñEasyAccess Manualò for 

more information. 
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5.5 Security 

 

Parameters in this tab configure the user passwords and security classes. There are two 

authentication modes: General Mode and Enhanced Security Mode. 

 

5.5.1 General mode 

 
 

Up to 12 sets of user and password are available. Password should be one non-negative 

integer. Once the password is entered, the objects that the user can operate are classified. 

There are six security classes available: A to F. 

If [None] is selected for an object, every user can access this object. 

 

For example, when the security class of User1 is set as below, User1 could only access 

objects of classes A, B, C and ñnoneò. For more information, please refer to ñChapter 10 

Securityò. 
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[Project password (EMTP file)] 

 

 

 

Users can set password to protect the project (emtp) files. The password set here must be 

entered when editing the project file.  

 

Select [Enable] then click [Setting], and the dialog below opens. 

 

Before editing a project, a popup window is shown for entering the password. Only when the 

password is correct can the user edit this project. 
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5.5.2 Enhanced security mode 

 

 

At most 11 users can be set here. An [Administrator] user is provided in this mode. An 

[Administrator] has all privileges and can operate all object classes. User passwords must 

be alphanumeric and each user can have up to 12 classes: A to L. 
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[Administrator] 

Default administrator account, cannot be deleted, has all privileges, and cannot be changed. 

Enhanced Security Mode can be used with [Option List] object. It displays the account 

names and privileges. 

If [Secret user] is checked, the account names and privileges will be hidden in [Option List]. 

 

[Control address] 

Enhanced Security Mode provides a [Control Address] for users to manage the accounts 

directly on HMI. Please refer to ñChapter 10.2ò for more details. 

 

[Select operable classes for each user] 

When selecting [Use existing user accounts on HMI] check box, the operable objects for 

each user will be decided by the account settings in HMI. 

 

 

 

[Execute auto. Login/logout when insert an USB key into HMI] 

 

This function allows automatic login / logout using an USB security key. The login / logout 

status will be written into a designated address. Insert the USB disk to HMI to log in, and 

remove the USB disk to log out. The result codes of login / logout: 

 

Code Result 

(0x00) No action 

(0x01) Login Succeeds 

(0x04) Login Fails 

(0x08) Logout Succeeds 

(0x10) Logout Fails 
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5.6 Font 

 

Parameters in this tab determine the non-ASCII fonts. 
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[Fonts for non- ascii strings] 

The non-ASCII fonts are listed above. When using non-ASCII characters or double byte 

characters (including Simplified or Traditional Chinese, Japanese, or Korean) which are not 

listed in [Fonts for non-ascii strings] table, EasyBuilder will select a font from the list to 

substitute for it automatically. 

 

The non-ASCII fonts in Windows can be added to the [Fonts for non-ascii strings] table. 

 

[Line spacing] 

Decide the space between lines in the text. 
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5.7 Extended Memory 

 

Parameters in this tab determine the location of the extended memory. 

 

 

 

Extended Memory is numbered from EM0 to EM9. It works in a way similar to other device 

types (i.e. LW or RW address). Users can simply select from [Device type] list while adding 

a new object. Size of each extended memory is up to 2G word. 
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Extended memories are saved as files in [SD card] or [USB disk]. [EM0] to [EM9] are 

saved as ñem0.emiò to ñem9.emiò respectively. Users can use RecipeEditor.exe to open 

these files and edit the data in the extended memory. 

 

Data in extended memory will not be erased when power is cut, which means next time 

when start up HMI again, data in the extended memory remains the same as before power 

off. This is similar to recipe data (RW, RW_A). The difference is that users can specify the 

location to store data. (SD card, USB disk) 

 

When the device of extended memory does not exist and to read data in it, the data content 

will be ñ0ò; to write data to a device that does not exist, the "PLC no response" message will 

be shown in HMI. 

 

HMI supports "Hot Swapping" function for SD card and USB devices. Users can insert or 

remove the device for extended memory without cutting the power. With this function, users 

can update or take data in extended memory. 
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5.8 Printer/Backup Server 

 

Configure remote printer / backup server. 

 

 

The settings are described below: 

 

Setting Description 

Output settings [Orientation] 

Set how will words or pictures be printed out, [horizontal] or 

[vertical]. 

[Printer size] 

Set to print out in [Original size] or to [Fit to printer margins]. 

[Margin] 

Set the top, bottom, right and left margin width. 
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Communication 

settings 

 

[IP address] 

Assign the IP address of the printer via network. 

[Port], [User name], [Password] 

Specify the data to log in printer.  

Port can be set from 1 to 65535. 

Maximum length of user name or password is 12 characters. 

Please refer ñChapter 26 EasyPrinterò for more information. 
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5.9 e-Mail 

 

Configure E-mail related parameters here. 

[Enable e-Mail function] 

Enable to configure the parameters. 

 

[Open Contact settings] opens the following dialog to edit contacts: 
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The settings are described below: 

Settings Description 

SMTP 

settings 

[Server] 

Set SMTP Server. 

[Port] 

Set communication port. 

[User name] 

Set e-mail address. 

[Password] 

Set e-mail password. 

[Confirm Password] 

Confirm e-mail password. 

[Log on using Secure Password Authentication (SPA)] 

Decide whether SPA is needed when log in e-mail. 

[Use the following type of encrypted connection] 

Decide whether the encrypted connections (TLS, SSL) are needed when 

sending e-mail. 

Sender 

Information 

[Name] 

Specify a name or use HMI name. 

[Mail Address] 

Setting e-mail address. 

Open 

Contact 

Settings 

[Contact List] 

Add or remove contacts from the list. 

[Group Information] 

Group up contacts. 

[No. of groups] 

Set no. of contact groups, according to the number, the groups are named 

from A to P and up to 16 groups can be set. 

[Current group] 

Current group. 

[Description] 

Description of the group. 

Please refer to ñChapter 7 EventLogò for more information. 

[Use existing contact settings on HMI] 

 

When this check box is selected, the system will use the contact settings in HMI. 
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5.10 Recipes 

 

Configure the recipe list for [Recipe Database]. 

 

The settings are described below: 

Settings  Description 

Recipes 

List 

[New] / [Delete] 

Add or delete a recipe. 

New [Item name] 

Enter recipe item name. 

[Data type] 

Setting item data type. 

[Size] 

Setting the size of the item. 

[Display width] 

Setting the width to display the item (Word).  

[Decimal Pt.] 

Setting the decimal place when displaying data. 

[Alignment] 

Setting the alignment when displaying data. [Align left], [Align center], and 

[Align right] can be selected. 
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Settings  All the item information can be user-defined and modified. 

 

Delete Delete the selected items. 

Please refer to ñChapter 24 Recipe Editorò for more information. 
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Chapter 6 Window Operations 
 

A window is a basic element in a project. With a window, all kinds of information like objects, 

pictures, and texts can be displayed on HMI screen. Total 1997 windows numbered from 3 ~ 

1999 in EasyBuilder can be built and edited. 

 

6.1 Window Types 

 

There are 4 types of windows, each with different functions and usages: 

(1) Base Window (2) Fast Selection Window (3) Common Window  

(4) System Message Window 

 

6.1.1 Base Window 

 

The most frequently used window, except for main screen, it can also be: 

ƴ A background of other windows. 

ƴ A keyboard window. 

ƴ A pop-up window of [function key] object. 

ƴ A pop-up window of [direct window] and [indirect window] objects. 

ƴ A screen saver. 

 

 

ƴ Base Window should be in same size as the HMI screen. Therefore, the resolution of the 

base window should set to the resolution of HMI. 

 

6.1.2 Fast Selection Window 

 

Window no. 3 is the default Fast Selection Window. This window can co-exist with base 

window. Generally, it is used to place the frequently-used buttons on the lower-left side or 

the lower-right side on the screen. Please create window no. 3 first, and set the relevant 

properties in [System Parameter Settings] » [General] tab. Apart from showing or hiding 

fast selection window with the button on the screen, there are system registers to do so: 

 

[LB-9013] FS window control [hide(ON)/show(OFF)] 

[LB-9014] FS button control [hide(ON)/show(OFF)] 

[LB-9015] FS window/button control [hide(ON)/show(OFF)] 
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6.1.3 Common Window 

 

Window no. 4 is the default Common Window. Objects in this window will be displayed in 

other base windows, not including popup windows. Therefore, the common objects in 

different windows are often placed in common window. 

 

When operating HMI, select [Function Key] » [Change common window] to change the 

source of common window. 

 

In menu [Option] » [Function 

Properties] select whether or not 

to [Display Common Window 

objects on Base Windows] when 

editing a project. This can avoid 

overlapping objects in base 

window with objects in common 

window. 

 

 

6.1.4 System Message Window 

 

Windows No. 5, 6, 7, 8 are the default System Message Windows: 

 

[Window No. 5: PLC Response] 

When the communication between PLC 

and HMI is disconnected, this message 

window will pop up automatically right on 

the base window currently opened. 

 

ƴ ñPLC no responseò window can be disabled by system registers. 

Please refer to ñChapter 22 System Reserved Words & Bitsò for more information. 

 

[Window No. 6: HMI Connection] 

When failing to connect HMI with a 

remote HMI, this message window will 

pop up automatically. 
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[Window No. 7: Password Restriction] 

When attempting to control 

an object without 

authorization, this window 

may pop up as a warning 

depending on the settings 

of the object. 

 

[Window No.8: Storage Space Insufficient] 

When HMI flash memory, USB disk or SD card run 

out of storage space, this message window will pop 

up automatically. (When the memory space is under 

4 MB) 

 

The following system registers can be used to check the free memory space in HMI, USB 

disk, or SD card: 

[LW-9072] HMI current free space (K bytes) 

[LW-9074] SD current free space (K bytes) 

[LW-9076] USB disk current free space (K bytes) 

To check if there is sufficient storage in the devices, the following system registers can be 

used. These addresses will set ON when the space is under 4 MB. 

[LB-9035] HMI free space insufficiency alarm (when ON) 

[LB-9036] SD card free space insufficiency alarm (when ON) 

[LB-9037] USB disk free space insufficiency alarm (when ON) 

 

The text shown in windows no. 5 ~ 8 can be edited for easier reference. 

 

20B 

Â A screen can display up to 16 popup windows simultaneous including System Message 

Window, Direct Window and Indirect Window. 

Â The system does not allow opening the same window with two Direct (or Indirect) 

Windows in one base window. 

Â Windows no. 3 to 9 are used by the system only, and windows no. 10 to 1999 can be 

edited based on actual usage. 
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6.2 Create, Set, and Delete a Window 

 

Check the existing windows in [View] » [Window Tree]. 

 

[Object list] displays window numbers and window names. Opened windows are marked 

with (*) sign. Press the (+) sign to see the object ID, address and description in this window. 

[Window preview] displays the thumbnails of windows. 

6.2.1 Creating and Setting a Window 

 

In window tree right click on a window 

number then select [New]. 

 
[Name] The name will appear on the title 
bar and also in window tree. 
 
[Window no.] can be 3 to 1999 
 
[Size] Set the window size in accordance 
with the HMI resolution. 
 
[Underlay window] [Popup window] 
Please refer to the description below. 
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[Underlay window] 

Underlay Window can be seen as an extra Common Window. When designing the project, 

the often used objects may be placed in different windows but not all windows. These 

objects can be placed in underlay window. 

Each base window can set three underlay windows as background, from [Bottom] to [Top]. 

The objects in underlay windows are displayed in this order in base window. 

 

[Popup window] 

Base window can also be used as a pop-up window. Use [X] and [Y] to set the coordinates 

indicating where in the screen will this base window pop up. The origin of the coordinates is 

the upper-left corner of the window. 

 

[Monopoly] 

If the option is selected, when the base window pops up, no operations of other popup 

windows and background windows are allowed until the monopoly window is closed. If a 

base window is used as a keyboard window, ñMonopoly" is automatically enabled. 

 

 

ƴ The objects in underlay window cannot be edited from the base window that displays them. 

To edit those objects, please open the underlay window where they are located. 

ƴ When the window number of the underlay window used by the base window is identical to 

the popup window, the popup window is disabled. 

ƴ When base window and popup window use the same underlay window, the objects in the 

underlay window cannot be displayed in popup window. 
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[Window] » [Open Window]  

Click [New] and select the type of the window and click [OK]. 

 

 

 

The way to call up [Window Settings] dialog: 

 

ƴ Right click on the window number in the window tree and select [Settings]. 

 

ƴ In [Window] » [Open Window] select the window then click [Settings].  

ƴ In the window, right click when no object is selected, and select [Attribute]. 
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6.2.2 Open, Close and Delete a Window 

 

Open an existing window: 

ƴ Double click on the window number in the window tree. 

ƴ In the window tree, select the window, right click, then select [Open]. 

ƴ In [Window] » [Open Window] select the window then click [Open]. 

 

Close or delete an existing window: 

ƴ In the window tree, select the window; right click, then select [Close] or [Delete]. 

ƴ In [Window] » [Open Window] select the window then click [Delete]. 

To delete a window, please close it first. 
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Chapter 7 Event Log 

 

7.1 Event Log Management 

 

               

 

 

 

 

 Alarm Bar / Alarm Display / Event Display 

Using these objects to view the process of 
the whole event from triggeringѷwaiting to 
be processedѷreturn to normal. Define the 
event content first. 
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The settings are described below: 

 

[Category] 

Classifies events by dividing them into 0 ~ 255 categories. Select one category to add or 

view event log. In the bracket ñ[ ]ò, it shows how many events are in this category. 

 

[History files] 

To specify the storage location of an event log. However, when executing On-line or Off-line 

Simulation on PC, the files will be saved in the HMI_memory / SD_card / USB folder under 

the installation directory. 

 

[Preservation limit] 

This setting determines how many days the data is preserved. For example, the [Days of 

preservation] is set to two days; the data of yesterday and the day before yesterday will be 

kept. Data that is built before this period will be deleted automatically to prevent the storage 

space from running out. 

 

[Print] 

In [System Parameter Settings] » [Model], select a printer. The printing format can then be 

set. 
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7.1.1 Excel Editing 

 

Click on the Excel icon in Event Log setting dialog to open the Excel template for a reference 

of editing. 

This template is under the installation directory, the file name is EventLogExample.xls. This 

template includes the ready-made dropdown lists and validation mechanism. 

 

 

 

 

1. [System tag] and [User-defined tag] cannot set to true simultaneously, otherwise, the 

system will view the User-defined tag to be a System tag, and [User-defined tag] to be 

false. If setting [Device type] to [User-defined tag], please set [System tag] to false. 

2. [Color] format is R:G:B, each should be an integer form 0 to 255. 

3. When setting [User-defined tag] to true, if the system compares the [Device type] with 

the user-defined tag in the system, and no suitable tag is found, the system will set the 

[User-defined tag] in event log to false. 

4. Before importing Label Library / Sound Library, please make sure the library names 

exist in the system. 
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7.2 Create a New Event Log 

 

7.2.1 Event (Alarm) Log General Settings 

 
Click [New] in the [Event (Alarm) Log] dialog, the dialog below appears. Select [General] 
tab. 

 

The settings are described below: 

[Category]  
Select event category, 0 ~ 255. 
 
[Priority level] 
When the number of events equals to the max number available in the system (default 1000), 
the lower priority events will be deleted and new events will be added in. 
 

[Read address] 
System reads data from this address to check if the event matches the trigger condition. 
 
[Notification] 
When enabled, the system will set the specified address ON or OFF when the event is 
triggered. 
 
[Condition] 
When [Bit] is selected, Event Log will detect the state of a Bit address. 
When [Word] is selected, Event Log will detect the value of a Word address to check if it is 
greater than, less than, or equals to a specified value. 
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The setting above indicates: 

When [Read address] value is greater than or equals to 29 (= 30 - 1)  

Or less than or equals to 31 (= 30 + 1), the event will be triggered. The trigger condition: 

 

29 Ò [Read address] value Ò 31 

 

After the event is triggered, when [Read address] value is greater than 32 (= 30 + 2) or less 

than 28 (= 30 - 2) the system will return to normal condition: 

  

[Read address] value < 28 or [Read address] value > 32 

 

 

 

The setting above indicates: 

When [Read address] value is less than 29 (= 30 - 1) 

or greater than 31 (= 30 + 1), the event will be triggered. The trigger condition: 

 

[Read address] value < 29 or [Read address] value > 31 

 

After the event is triggered, when [Read address] value is greater than or equals to 28 (= 30 

- 2) or less than or equals to 32 (= 30 + 2) the system will return to normal condition: 

 

28 Ò [Read address] value Ò 32 
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7.2.2 Event (Alarm) Log Message Settings 

Select [Message] tab: 

 

The settings are described below: 

[Content] 

The text content displayed in [Alarm Bar], [Alarm Display], and [Event Display] objects. Use 

the formats in the following two examples or WATCH addresses to use register data in 

content. 

 

The data of the LW register can be used in the content displayed when an event is triggered: 

Format: %#d (% -> initial sign, # -> address, d -> end sign) 

When an event is triggered, if the value in LW-20 is 13: 

Setting: ñHigh Temperature = %20dòŸ Display: ñHigh Temperature = 13ò 
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The data in the specified address when the event is triggered can be included in the content 

displayed. The address should be set to the [Read address] of Event Log, take MODBUS 

RTU 4x address as an example: 

Format: $#d ($ -> initial sign, # -> address, d -> end sign) 

When an event is triggered, if the value in MODBUS 4x-15 is 42: 

Setting: ñHigh Temperature = $15dò Ÿ Display: ñHigh Temperature = 42ò 

 

[Font] / [Color] 

The font and color can be set differently for each event. The setting determines the font and 

color shown in [Alarm Bar], [Alarm Display] or [Event Display] objects. 

 

[Write value for Event/Alarm Display object] 

When an event in [Event Display] or [Alarm Display] is acknowledged, the value is written to 

the assigned [Write address]. 

 

[Sound] 

 

 

If enabled, the selected sound will be played when an event is triggered. Continuous beep 

can also be enabled, which only stops when the event is acknowledged or recovered. 

For continuous beep, a delay time can be set between triggering the alarm and the start of 

beeping. 

 

[Address of WATCH 1 ~ WATCH 8] 

Click [Syntax] to edit and display the value in watch address when the event is triggered. Up 

to 8 watch addresses can be set. 
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7.2.3 Event (Alarm) Log e-Mail Settings 

Please enable this function in [System Parameter Settings] » [e-Mail] first. 

Select [e-Mail] tab: 

 

The settings are described below: 

[Recipients] 

Select the [To], [Cc], and [Bcc] recipients. 

[Subject] 

Enter the subject of the e-mail. 

[Message] 

Enter the content of [Opening] and [Ending] of the e-mail. 

[Attach] 

If the [Contains a screenshot of window] check box is selected, the screenshot of the 

selected window will be attached. 
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Chapter 8 Data Sampling 

 

 

 

 

 

 

 

 

8.1 Data Sampling Management 

Create a new Data Sampling object first by the following steps: 

1. From the menu select [Objects] and click on [Data Sampling]. 

2. Click [New] to finish relevant settings: 

 

 

Define how the 
data is sampled  
1. sampling time 
2. address 
3. data length 

Save the sampled 
data to the 
designated 
location, such as 
HMI, SD card, 
USB disk. 

Use Trend Display 
and History Data 
Display objects to 
display sampling 
records. 
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8.2 Create a New Data Sampling 

 

The following introduces how to add a new Data Sampling: 

 

1. [Sampling mode] 

[Time-based] mode samples data in a fixed frequency. The [Sampling time interval] can 

be set from ñ0.1 second(s) to 120 minsò. 

 

 

[Trigger-based] mode triggers data sampling by the status of a designated address. 

[Mode] 

Conditions to trigger Data Sampling: 

[OFF -> ON] Trigger sampling when the status of the address changes from OFF to ON. 

[ON -> OFF] Trigger sampling when the status of the address changes from ON to OFF. 

[OFF <-> ON] Trigger sampling when the status of the address changes. 

 

1. 

2. 

3. 

4. 

5. 

6. 
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2. [Read address]  

Specify an address to be the source of Data Sampling. 

 

 

3. [Data Record]  

The max. number of data records can be saved by one Data Sampling in one day is 86400. 

(1 record per second for 24hours) If [sampling time interval] is set to ñ0.1 secondò, the max. 

number of data records is still 86400.  

 

[Data Format] 

Available to read several data in different format. 

 

[Auto. stop] 

This function depends on the arrangement of different objects and modes. (Set [Max. data 

records] to n.)  

 

Objects not selecting [Auto. stop] 
 
selecting [Auto. stop] 
 

Trend Display - Real Time 

Deletes the earlier records 
and displays the latest 
number of records (n) in 
Trend Display. Please refer 
to the following figure. 

Stops after reaching the 
specified number of data 
records (n). 

Trend Display - Historical 
Keeps on sampling data and 
displays all history data in 
Trend Display. 

Stops after reaching the 
specified number of data 
records (n). 

History Data Display 

Keeps on sampling data and 
displays all history data in 
History Data Display. 

Stops after reaching the 
specified number of data 
records (n). 

Data Sampling 

Keeps on sampling new 
data. 

Stops sampling after 
reaching the specified 
number of data records (n). 
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The figure illustrates how the data is sampled in Trend Display ï Real Time mode when 

Auto. stop check box is not selected. 

 

As shown in the preceding figure, if Data length is set to 10, when the 11th data is generated, 

the oldest data is deleted, and the newest data is added. 

 

 

Â A Data Sampling may include more than one type of records. Data Sampling can 

retrieve different types of records at the same time. For example, user defines three 

types of data, 4 words in total. In this way, system retrieves a 4-word data each time 

from the designated address to be the content in one Data Sampling. 

Â When running simulation and save data sampling records, to change the data format, 

be sure to delete the previous data records in the installation directory to avoid the 

system to read the old data records. 

 

4. [Clear address] 

Set when the bit address status changes from [OFF -> ON] or [ON -> OFF], clear the 

sampled data in Trend Display Real-time Mode. The number of data records returns zero 

but the data records that are already saved will not be cleared. 

 

5. [Hold address] 

If the status of the designated address is set ON or OFF, sampling will be paused until the 

status of the designated address returns. 
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6. [History files]  

 

[Save to HMI momery] 

Save Data Sampling to HMI only when its size reaches 4kb. Or, use system register 

[LB-9034] to force storing data. 

[Save to SD card / USB disk] 

Save Data Sampling to the specified external device. 

[Folder name] 

Specify Data Sampling file name which must be all in ASCII characters. 

The folder name will be written as: [Storage Location] \ [Folder Name] \ yyyymmdd.dtl 

The files are saved in the specified folder according to the date the file is generated. 

 

As shown in the following figure, the files are saved in the Test folder according to date. 
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[Preservation limit] 

This determines how many days the data is to be preserved. 

 

 

Â If [Preservation limit] is set to 2 days, the data of yesterday and the day before 

yesterday will be kept. Data that is not built in this period will be deleted to prevent the 

storage space from running out. 

Â When running simulation on PC, all data sampling will be saved to the datalog folder in 

the storage location. 
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Chapter 9 Object General Properties 

 

[General] properties of an object includes: 

 

1. Selecting the PLC device 

2. Setting the read/write address 

3. Using Shape Library and Picture Library 

4. Setting label text 

5. Adjusting profile size 

 

9.1 Selecting the PLC 

 

Most objects require specified PLC devices, as shown below. Select the PLC to be 

controlled at [PLC name]. In this example there are two devices: ñLocal HMIò and 

ñMitsubishi FX0s/FX0n/FX1s/FX1n/FX2,ò which come from [System Parameters Settings] 

» [Device List] 

 

 

 

9.1.1 Setting Read and Write Address 

 

 

 

The settings of read/write address include: 

 



                                                             Object General Properties 
 

 99 

 

[PLC name] 

Select the PLC type. 

 

[Device type] 

Different PLC has different device types. 

 

 

 

[Address] 

Set the read/write address. 

 

[System tag] 

Address tags include [System Tag] and [User-defined Tag]. This option allows users to use 

[System Tag]. [System Tag] consists of the preserved addresses by system for particular 

purposes. The address tags have bit registers or word registers (LB or LW).  

After selecting [System tag], not only will the [Device type] display the chosen tag, but 

[Address] will also display the chosen tag as shown below.  
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The figure below shows a part of system tags. For more information, please refer to ñChapter 

16 Address Tag Libraryò and ñChapter 22 System Reserved Words and Bitsò. 

 

 

 

[Index register] 

Select this check box to use the [Index Register], please refer to ñChapter 11 Index Registerò 

for more information. 

 

Selecting Data Type 

EasyBuilder supports data types that are listed below. Selecting correct data type is 

necessary especially when using address tag. 

 

 

 



                                                             Object General Properties 
 

 101 

 

9.2 Using Shape Library and Picture Library 

 

Shape Library and Picture Library are used to add visual effects on objects. Select [Shape] 

tab to use the libraries when creating an object: 
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9.2.1 Settings of Shape Library 

 

[Shape Libraryé] 

Select [Use shape] check box and select a shape from the library. See next page. 

 

[Inner] 

Select this check box to set the inner part of a shape. Click the drop down button to select a 

color or customize a color and click [Add to Custom Colors]. EasyBuilder will save this 

color. 

 

[Frame] 

Select this check box to set the frame of a shape. Click the drop down button to select a 

color. 

[Interior Pattern] 

Set the color of the interior pattern of the shape.  

[Pattern Style] 

Click this button to select a pattern. 
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[Duplicate these attributes to every state] 

Duplicate all attributes of the current state to other states. 

 

How to set [Shape Libraryé] 

Click [Shape Libraryé] button to open the [Shape manager] dialog. The currently selected 

shape is highlighted yellow. 

 

 

 

 

 

The illustration above provides information of one of the Shapes in the Shape Library as 

follows: 

Shape5 The name of the shape. 

States: 2 The number of states of the shape.  

Objects: 1 Indicates that the shape is used by 1 object in the project. 
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As shown below, the shape has two states, State 0 and State 1, and contains only ñinnerò 

but not ñframe.ò 

 

 

Please refer to ñChapter 14 Shape Library and Picture Libraryò for more details. 

When finished, click [OK], and the object will use the selected shape: 
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9.2.2 Settings of Picture Library 

 

[Picture Library] 

Select [Use picture] check box to select a picture from the library. 

 

How to set [Picture Libraryé] 

Click [Picture Libraryé] button to open the [Pictures manager] dialog. The currently 

selected picture is highlighted yellow. 
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The illustration above provides information of one of the Pictures in the Picture Library as 

follows: 

 

clock The name of the picture 

States: 3 The number of states of the picture 

Objects: 2 Indicates that the picture is used by 2 objects. 

     

Please refer to ñChapter 14 Shape Library and Picture Libraryò for more details. 

 

When finished, click [OK], and the object will use the selected picture: 
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9.3 Setting Label Text 

 

Select [Label] tab when creating an object to use the libraries: 

 

 

 

[Use label] 

Select this check box to use labels for the object.  
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[Use label library] 

Select this check box to choose a label in Label Library. 

 

 

[Label Library] 

Please refer to ñChapter 15 Label Library and Multi-Language Usageò for more details. 

 

[Font] 

Select a font from the list. EasyBuilder supports Windows True-type fonts. 

 

 

[Color] 

Select the font color. 

 

[Size] 

Select the font size.  

 

[Align] 

Align the multiple lines of the text. 

 

.  

 

The text aligned [Left]. 
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The text aligned [Center]. 

 

 

The text aligned [Right]. 

 

 

 

[Blink] 

Specify the way the text blinks:  

Choose [None] to disable this feature or set the blinking interval to [1 second] or [0.5 

seconds]. 

 

 

[Italic] 

Use Italic font. 

 

 

[Underline] 

Use Underline font. 

 

 

[Movement] setting 

[Direction] 

Set the direction of the marquee effect. 
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[Continuous] 

Specify how the marquee effect is displayed: 

 

 

 

If not selecting this check box, the next text appears only when the previous text disappears 

completely. See the picture below. 

 

  
 

 

If selecting this check box, the text will be displayed continuously. 

 

 

 

[Speed] 

Adjust the speed of the text movement. 

 

[Content] 

Set the content of the text. If [Label Library] is used, it will automatically use the text defined 

in Label Library. 

 

[Tracking] 

If this check box is selected, when changing the position of the text in one state, the text 

position in the other states will also change in accordance. 

 

[Duplicate this label to other states] 

Duplicate the current text to the other states. 
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9.4 Adjusting Profile Size 

 

When an object is created, double click it and select the [Profile] tab to adjust the position 

and size of the object. 

 

 

 

[Position] 

[Pinned] 

When this check box is selected, the position and the size of the object cannot be changed.  

[X] and [Y] are the coordinates of the position of the object in the editing screen. 

 

[Size] 

Adjust the [width] and [height] of the object. 

 

 



                                                             Object General Properties 
 

 112 

 

9.5 Variables of Station Number 

 

EasyBuilder allows users to set the variables of station number in PLC address. As shown 

below, ñvar2ò is one of 16 station number variables. 

 

 

 

The syntax of the variable of a station number is: varN#address 

In which N is an integer number from 0 to 15, and address means PLC register address. 

There are 16 variables to control the station number, from var0 to var15. The values of these 

variables are read from address LW-10000 to LW-10015 respectively. The list below shows 

the variables and the corresponding system reserved addresses: 

 

var0   LW10000 

 var1   LW10001 

var2   LW10002 

 var3   LW10003 

var4   LW10004 

 var5   LW10005 

var6   LW10006 

 var7   LW10007 

var8   LW10008 

 var9   LW10009 

var10   LW10010 

 var11   LW10011 

var12   LW10012 

 var13   LW10013 

var14   LW10014 

 var15   LW10015
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For example, [var0] reads value from LW-10000, when the value in LW-10000 is ñ32ò, 

var0#234 means 32#234, where the station number is 32. Similarly, [var13] reads value from 

LW-10013, when the value in LW10013 isò 5ò, var13#234 = 5#234. 
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9.6 Broadcast Station Number 

 

HMI provides two ways for users to enable broadcast command. First is to set the PLC 

parameter directly in [system parameter settings]: 

 

 

 

The second way is to use system tag to enable or disable broadcast station number or to 

change it.  

The corresponding system tags are listed below: 

 

LB-9065  disable/enable COM 1 broadcast station no. 

LB-9066  disable/enable COM 2 broadcast station no. 

LB-9067  disable/enable COM 3 broadcast station no. 

 

LW-9565 COM 1 broadcast station no. 

LW-9566 COM 2 broadcast station no. 

LW-9567 COM 3 broadcast station no. 
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Chapter 10 User Password and Object Security 

This chapter discusses the protection for 

operations provided by setting up user 

passwords and security classes.  

There are two authentication modes: 

1. General Mode 

2. Enhanced Security Mode 

Each mode will be introduced later. 

 

To set up the protection system, please:  

1. Set user password and operable classes. 

2. Set object class for objects. 

An object belongs only to one security class. Setting the object class to ñNoneò means any 

user can operate this object. 

10.1 User Password and Operable Object Classes 

The security parameters can be found in [Edit] » [System Parameter Settings] » 

[Security].  

Two modes are available: General Mode and Enhanced Security Mode.  

10.1.1 General Mode 

Up to 12 sets of user and password are available. Password should be one non-negative 

integer. There are six security classes: A to F. 

Once the password is entered, the objects that the user can operate are classified. As 

shown below, ñUser 1ò can only operate objects with class A or class C. 
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10.1.2 Enhanced Security Mode 

Up to 11 users can be set here. [Administrator] setting is provided. Administrator has all 

privileges and can operate all object classes. User passwords must be alphanumeric and 

each user can have up to 12 classes: A to L. (Up to 127 users can be set in Administrator 

Tools. Please refer to Chapter 10.3 for more details.) 

 

Enhanced Security Mode provides a [Control address] for users to manage the accounts 

directly on HMI. Please refer to Chapter 10.2 for more details. 

Or, use USB Security Key to log in automatically. Insert the device in which the key is saved 

to log in. Please refer to Chapter 10.3.3 for more details. 
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10.2 Enhanced Security Mode and Control Address 

The Control Address is used for login and account management. The Control Address can 

only be assigned to LW register on Local HMI, and 20 consecutive registers will be used. To 

log in using Control Address, please select to log in by [user name] or [user index]. 

Please set [user name] and [password] in [System Parameter Settings] » [Security] » 

[Enhanced security mode] in advance. 

10.2.1 Control Address Settings 

When control address is set to LW-n, where n is an arbitrary number, the following 

addresses will be designated: 

Address Tag Name Description 

LW-n  

(1 word) 

command Commands to be executed: Login, Logout, 

Add/Setting/Delete Accounts, etc. 

LW-n + 1  

(1 word) 

command execution result Displays the result of executing commands. 

LW-n + 2  

(1 word) 

user index The index of accounts (used with Option List 

Object). 

LW-n + 3  

(1 word) 

user privilege Binary value. Level A = bit0, Level B = bit1, é 

LW-n + 4  

(8 words) 

user name Account name (Only letters, numbers, ñ-ò or 

ñ_ò, case-sensitive). 

LW-n + 12  

(8 words) 

password Account password (Only letters, numbers, ñ-ò 

or ñ_ò, case-sensitive). 

 

After setting the [Control address], the relevant addresses can be found in [Address Tag 

Library] » [Customized]. 

For example, setting [Control address] to LW-0: (UAC stands for User Account Control) 

LW-0 Ą [UAC command] 

LW-1 Ą [UAC command execution result] 

LW-2 Ą [UAC user index] 

LW-3 Ą [UAC user privilege] 

LW-4 ~ LW-11 Ą [UAC user name] 

LW-12 ~ LW-20 Ą [UAC password] 



                                                     User Password and Object Security 
 

                                                                                           118 

10.2.2 Commands 

Setting different values in LW-n [command] enables different commands: 

Set Value Command Corresponding Address 

1 Log in by user name Set [user name] and [password] first. 

After entering the user name and 

password, the system will check if they are 

valid in [System Parameter Settings] » 

[Security] » [Enhanced security mode]. 

2 Log in by user index Set [user index] and [password] first. 

Please refer to 10.4 Enhanced Security 

Mode with Option List Object. 

3 Log out  

4 Change the password of 

current logged-in user 

Set [user name] and [password] first. 

Please fill in the original password in [user 

name] and new password in [password]. 

5 Add an account Set [user name], [password] and [user 

privilege] first. 

6 Add a temporary account Set [user name], [password], [user 

privilege], and [user index] first. The 

index is for specifying an effective time 

period (minutes). If 0 is specified, this 

account is valid until HMI is turned off. 

7 Delete an existing account by 

user name 

Set [user name] first. 

8 Delete an existing account by 

user index 

Set [user index] first. 

9 Setting the privilege of an 

existing account by user name 

Set [user name] and [user privilege] first. 

10 Setting the privilege of an 

existing account by user index 

Set [user index] and [user privilege] first. 

11 Setting the password of an 

existing account by user name 

Set [user name] and [password] first. 

12 Setting the password of an 

existing account by user index 

Set [user index] and [password] first. 

 

13 Read the privilege of an 

existing account by user name 

Set [user name] first. If the command 

succeeded, [user privilege] can be 

displayed. 
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14 Read the privilege of an 

existing account by user index 

Set [user index] first. If the command 

succeeded, [user privilege] can be 

displayed. 

 

ƴ Add a temporary account: The difference between general accounts and temporary 

accounts is that temporary accounts will not be stored in the system; therefore, it is invalid 

after HMI turned off. The temporary accounts will be automatically deleted when they are 

expired. 

ƴ Delete the existing account: The currently logged in account cannot be deleted.  

ƴ Offline/Online Simulation: Simulate using the account settings in the program. Any 

modifications of the account during simulation will not be reserved for next simulation. 

ƴ Admin: Default administrator account, cannot be deleted, has all privileges and cannot be 

changed. 

ƴ System Register LW-10754: Displays current user name. 

10.2.3 Command Execution Results 

After the command is executed, the system will store the result code to control address 

LW-n + 1. The listed result codes below are shown in hexadecimal.  

Result Codes Command execution result 

(0x001) Succeeds 

(0x002) Invalid command 

(0x004) Account exists (when adding a new account) 

(0x008) Account not exists 

(0x010) Password error 

(0x020) Deny command 

(0x040) Invalid name 

(0x080) Invalid password character exists 

(0x100) Invalid import data 

(0x200) Out of validity range (when log in by USB Security Key). The [Effective 

Time] can be set in Administrator Tools. 

 

ƴ Users can add a new event in Event (Alarm) Log, and designate the [Read address] to 

LW-n + 1 [command execution result]. Open [Message] tab » [Text] » [Content] and 

specify the message to be displayed in Event Display Object for showing command 

execution result. 
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10.3 Enhanced Security Mode-related Usage 

The user accounts can be set using other tools we provide, apart from the settings in 

[System Parameter Settings] » [Security] tab. 

10.3.1 Importing User Accounts 

Administrator Tools can also be used to set user accounts. Administrator Tools can be found 

in the installation directory. After the program starts, select the [User Accounts] check box. 

Up to 127 accounts can be added.  

 

 

 

For the details of Administrator Tools, please refer to ñChapter 36 Administrator Toolsò. 

The added accounts can be stored in USB disk or SD card and imported in HMI by a 

Function Key Object.  

To do so, create a Function Key Object, and select [Import user accounts]. 
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When finished, insert the external device to HMI, and press Function Key to import accounts. 

If [Overwrite] is selected, the existing accounts will be overwritten with new accounts and 

automatically log out after importing. If select [Delete file after importing user accounts] 

check box, the system will delete the account data saved in the external device after 

importing. If the [Effective Time] in Administrator Tools is specified, the importing can only be 

done in the time limit specified. The imported accounts will not be deleted by system when 

the effective time ends. 
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10.3.2 Login with USB Security Key 

Instead of entering user name and password to login, a key can be used to do so. In 

EasyBuilder Pro installation directory, launch Administrator Tools, select [USB Security 

Key] check box. The account information uses the predefined data in [System Parameter 

Settings] » [Security]. 

 

 

 

Please note that the user accounts used for USB Security Key must already exist in HMI.  

For the details of Administrator Tools, please refer to ñChapter 36 Administrator Toolsò. 

USB Security Key can be stored in USB disk or SD card, and create a Function Key to log in 

by USB Security Key as shown below: 
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When finished, insert the external device to HMI, and press Function Key to log in using 

USB Security Key. If the [Effective Time] in Administrator Tools is specified, the login can 

only be done in the time limit specified. The system will log out automatically when the key 

expires. 
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10.3.3 Login / Logout Automatically with USB Security Key 

As shown below, in [System Parameter Settings], select [Enable] check box for [Execute 

auto. Login / logout when insert an USB key into HMI]. 

 

 

 

This function allows automatic login / logout using an USB security key. Insert the USB disk 

in which the key is saved to HMI to log in, and remove the USB disk to log out. The login / 

logout status will be written into a designated address, the result codes of login / logout: 

 

Code Result 

(0x00) No action 

(0x01) Login Succeeds 

(0x04) Login Fails 

(0x08) Logout Succeeds 

(0x10) Logout Fails 

 

For more details about USB Security Key, please refer to Chapter 36 Administrator Tools. 

 

 

Â When Auto Login / Logout is enabled, [Function Key] object is disabled to log in, but it is 

still available to log in / out with a designated control address. 

Â This function does not support On-line / Off-line simulation. 

Â Only the USB Security Key saved in USB disk is valid. 

 

Want to know more about Enhanced Security Mode?  

 

Please confirm your Internet connection before downloading the demo project. 

http://www.weintek.com/Download/eMT3000/Project/System_Sample/Demo_USB_Auto_Login_Logout.zip
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10.3.4 Enhanced Security Mode with Option List Object 

Enhanced Security Mode uses Control Address LW-n + 2 as account index. With Option List 

Object, account names and privileges can be displayed. Users can select whether or not to 

display the account privileges and secret users in Option List. Secret users are set to be 

hidden in [System Parameter Settings] » [Security] » [Enhanced Security Mode]; their 

account names will be hidden in Option List if [Secret user] check box is not selected. 

 

If the control address is set to LW-0, the monitor address for index of Option List is 

designated to LW-2. 

 

Want to know more about Enhanced Security Mode?  

 

Please confirm your Internet connection before downloading the demo project. 

http://www.weintek.com/Download/eMT3000/Project/2011SPSdemo/Enhanced_Security.zip
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10.4 Object Security Settings 

[Safety control] 

Use [Min. press time (sec)] to 

avoid miss operations. Press and 

hold the object longer than the 

[Min. press time] set here to activate the object. 

[Display confirmation request] After pressing the 

object, a dialog appears for operation confirmation. If 

the response to this dialog comes later than the set 

[Max. waiting time (sec)], this dialog disappears 

automatically and the operation will be canceled. 

[Interlock] 

When this check box is selected, 

the specified Bit address is used 

to enable or disable the object. 

As shown, if LB-0 is ON, the 

object is enabled. 

[Hide when disabled] When 

the specified Bit is OFF, hide the object.  

[Grayed label when disabled] When the specified Bit is OFF, the 

label font of the object turns gray. 

[User restriction] 

Set the security class of the 

object to be operated by an 

authorized user. 

[Object class]  

ñNoneò means any user can operate this object. Only account ñadminò can operate 

ñAdministratorò object class. 

[Disable protection permanently after initial activation] Once the permitted class of the 

user matches that of the object, the system will stop checking the security class permanently, 

that means, any user can operate this object freely after it is unlocked. 

[Display warning message if access denied] When 

an unauthorized user attempts to operate the object, a 

warning dialog (Window no. 7) appears. The content of 

the message in the dialog can be modified. 
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[Make invisible while protected] When the user's privilege does not match the object class, 

hide the object. 

10.5 Example of Object Security Settings 

The following shows an example of setting object security class: 

1. Create a project, go to [System Parameter Settings] » [Security] » [General] to enable 

3 users: 

User 1 = 

Operable class: A 

User 2 = 

Operable class: A, B 

User 3 = 

Operable class: A, B, C 

 

2. Design Window no. 10 as shown: 

Create two [Numeric Input] objects: 

[LW-9219]  

User no. (1~12)  

Length = 1word 

[LW-9220]  

For entering user password. 

Length = 2 words 

Create a [Numeric Display] object  

[LW-9222]  

Displays the status of current user.  

(16-bit Binary) 

Create a [Set Bit] object 

[LB-9050] logout 

 

Create three [Set Bit] objects, each set to different classes but all select [Made invisible 

while protected]. 

 

After setting, please save and compile the project and execute off-line simulation. The below 

shows how it works when simulating. 
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3. Before entering the password, it displays ñ0000000000000000ò, which means that the 

user operable object class is ñNoneò. [Class A Button] ~ [Class C Button] objects are 

classified from ñAò to ñCò and selected [Made invisible while protected]; therefore they are 

hidden at this moment. 

4. Enter User 1 password ñ111ò. 

Since User 1 is only allowed to operate 

class A objects, [Class A Button] object 

appears for operating. [LW-9222] bit 0 

turns to ñ1ò means that user can 

operate class A objects. 

5. Enter User 3 password ñ333ò. 

Since User 3 is allowed to operate 

class A, B, C objects, [LW-9222] bit 0 

~ bit 2 turns to ñ1ò, means that user 

can operate class A ~ C objects. 

6. Click [Logout] button to log out, the 

system will return to the initial state, 

and current user can only operate 

class ñNoneò objects. 
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ƴ Password input: If the password is incorrect, [LB-9060] will be ON; if the password is 

correct, [LB-9060] will be OFF. All user passwords (User 1 to User 12) can be obtained from 

system registers [LW-9500] ~ [LW-9522], 24 words in total. 

ƴ Changing password directly on HMI: When [LB-9061] is set ON, the system will read 

data in [LW-9500] ~ [LW-9522] to update user password. The new password will be used in 

the further operations. Please note that the user operable object classes will not be changed 

due to the change of password. 
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Chapter 11 Index Register 
 

11.1 Introduction 

 

EasyBuilder provides Index Registers for users to change addresses flexibly. With Index 

Registers, users can change objectôs read/write address directly on HMI without changing its 

settings. There are 32 Index Registers, divided into 16-bit and 32-bit. 

 

 

 

 

 

 

 

 

 

16-bit Index Register: 

Index 0 [LW-9200] (16-bit)~ 

Index 15 [LW-9215] (16-bit) 

Max. address range: 65536 words. 

 

 

32-bit Index Register: 

Index 16 [LW-9230] (32-bit)~ 

Index 31 [LW-9260] (32-bit) 

Max. address range: 4294967296  

words. 

 

While using [Index register], the address is designated by the following equation:  

The constant set in [Address] + the value in the chosen Index Register. 

 

 

Index Registers work for all devices in [System Parameter Settings] » [Device list], but 

are limited to word registers only.

Address 

Address 



                                                                      Index Register 
 

                                                                                           131 

 

11.2 Examples of Index Register 

 

The following examples show how to use Index Registers. 

  

If not selecting [Index 

register] check box and 

set read address to 

[LW-10]. The system will 

directly read / write LW-10. 

 

 

If select [Index register] 

check box and set index 

register to [INDEX 0]. 

Read address = [LW-0 + 

INDEX 0] 

As shown in the beginning, 

Index 0 indicates register 

[LW-9200]. If the data in 

[LW-9200] is ñ5ò, read 

address is set to [LW(0+5)] = [LW-5]. 

 

Hereôs a demo project shown as an example: 
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Index Function of Word 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Index Function of Bit 

In the same way, Index Register can be used for Bit address. 

1 Word = 16 Bit, adding 1 in the value of index register = adding 16  

 

The switch [LB-0 + Index 6] reads LB-16 = ON 

Index 6 is set to 2 The switch [LB-0 + Index 6] reads LB-32 = OFF 

Index 6 (LW-9206) 

is set to 1 

If the value in 

Index 0 (LW-9200) 

is 0. 

 

Read [LW-0 + Index 0] 

= Read [LW-0] 

 

[LW-10] is set to 3 

[LW-20] is set to 6 

If the value in  

Index 0 (LW-9200)  

is 10 

Read [LW-0 + Index 0] 

= Read [LW-10] = 3 
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Â When using Index Registers for bit addresses, 16 bit addresses will be calculated as 

one unit. EX: If the target is LB-0, and set the value in Index Register to 1, LB-16 will be 

activated. If set the value in Index Register to 2, LB-32 will be activated. 

 

Index Register is used to change addresses. Through changing the data in Index Register, 

user can make an object to read and write different addresses without changing its own 

address settings. Therefore user can transmit or exchange data among different addresses. 

 

 

Please confirm your internet connection before downloading the demo project. 

ftp://ftp.weintek.com/MT8000/Project/System_Sample/Index_Function.zip
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Chapter 12 Keyboard Design and Usage 
 

Numeric Input and ASCII Input objects need keyboard as an input tool. 
Both numeric keyboard and ASCII keyboard are created with Function Key object. 
The types of the keyboards are: 
 

1. Fixed Keyboard. 

 
 

2. Popup Keyboard. 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

3. UNICODE Keyboard. 

 

 

 

Popup keyboard 

Fixed keyboard  
on the window 

Popup keyboard 

without title bar. 

Popup keyboard 

with title bar. 
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12.1 Steps to Design a Popup Keyboard 
 

Step 1 Create and open a window for the new keyboard. For example, set to ñwindow no. 

200ò. 

 
 

Step 2 Adjust the height and width of ñwindow no. 200ò and create a variety of Function Key 

objects in [ASCII/UNICODE mode]. 

For example: 

 

[FK_11] is used as the [Esc] key. 

 

 

[FK_14] is used as the [Enter] key. 

 

 

FK_11 

FK_14 

FK_0 
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The rest are mostly used to enter numbers. For example, [FK_0] is used for entering number 

ñ1ò. 

 

 

Step 3 Select a suitable picture for each Function Key object and placed at the bottom layer 

as a background. 

 
 

Step 4 Select [System Parameter Settings] » [General] » [Keyboard] » [Add] to add 
ñwindow no. 200ò. Up to 32 keyboards can be added. 
 

 

 

Step 5 After the keyboard window is added, when creating Numerical Input and ASCII Input 

objects, ñ200. Keyboardò can be found in [Data Entry] » [Keyboard] »  

[Window no.]. The [Popup position] is for designating the display position of the keyboard 

on the screen. The system divides the screen into 9 areas. 
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Step 6 Select ñ200.Keyboardò. When users press Numerical Input or ASCII Input objects on 

the screen, ñwindow no. 200ò will pop up. Users can press the keys on the keyboard to enter 

data. 

 
































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































































